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t can seem overwhelming: the digital 
art phenomenon. Every day new pro-
grams are invented for artists look-

ing to enhance and expand their creative 
process using digital tools. We can pro-
claim our purity and reject the computer, 
or we can use it in different—radical or 
subtle—ways. Some artists create work 
from start to finish on the computer; 
some use the computer to modify work, 
and some use it to produce work that 
they’ll add to a collage. In this article 
we’ll take a look at all three possibilities.

Digital Art
Whether you’re intrigued  

by or indifferent to digital art, 
you should know that it’s  
not necessary to abandon  

paints and brushes  
to enter the digital age. 

n By Ursula Roma

Dip Your Brush in 

God and The Devil Argue Over the Details (giclée on 

stretched canvas, 60x36) by Kevin Mack
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As for me, I’ve loved and adored my Apple 
Macintosh, using it primarily for producing graphic 
design work, for more than 20 years. The computer 
indeed has made design and layout much less process-
oriented. I can’t imagine going back to waxing type, 
cutting with X-Acto blades and taping key lines. For the 
last 10 years, however, I’ve used my computer for much 
more than designing type and images. On my Mac, I 
not only create illustrations but also manipulate, adjust, 
change, enlarge, reduce, saturate, de-saturate, pixellate, 
brighten and print artwork. 

The myriad number of programs out there can 
be confusing. Basically, there are two types: vector-
based and pixel-based. Vector-based drawing programs, 
such as Adobe Illustrator, CorelDRAW, Microsoft 
Expression Design and XaraXtreme, help you cre-
ate original digital artwork 
using digital drawing tech-
niques. Pixel-based painting 
programs like Adobe Photoshop, 
Corel Painter, ArtRage, Alias 
Sketchbook Pro, Corel Paint 
Shop Pro and others help you 
create original digital artwork 
using digital painting tech-
niques. These are just a few of 
the programs available, and 
some artists use multiple pro-
grams in the process of creat-
ing one piece of digital art. They 
may scan the art into Photo-
shop, make some changes, then bring it into Illustra-
tor and finish it, and so on. As long as the file formats 
are compatible, the variation of uses and outcomes are 
endless.

Step 1: Adding color by way of computer 
I most often make a piece of art with traditional fine 
art techniques, such as pen and ink, scratchboard 
or cut-paper. Then I add color in Adobe Photoshop, 
though typically Illustrator would be appropriate, 
too, because of its flexibility to change size and other 
characteristics of the drawing. 

Benefits: The computer provides a very efficient 
way to explore color ideas and combinations. No more 
markers to buy; no more photocopies to make, correct 
and paint on; no more smudging and ruining a piece 
beyond repair. I experiment on the computer until I cre-
ate a finished piece of art that satisfies me, and I might 
mix several programs in the process. As in traditional 
painting, sometimes the accidents create the nicest 
effects (and you don’t have to re-gesso the canvas).

Step 2: Using digital images as design elements 
Merle Rosen combines computer-generated imag-
ery with traditional media, acrylic mediums and vary-

n Ursula Roma is an graphic designer, muralist, illus-
trator, sculptor and painter; she lives in Cincinnati.

Adding and altering color

Here is the original, intricately patterned cut paper artwork Ursula 

Roma created with black paper and an X-Acto knife.

The computer provides a 
very efficient way  

to explore color ideas and 
combinations. No more 

markers to buy—no more 
photocopies to make.
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“I cleaned up the edges but didn’t want to get too far 

away from this looking like a hand-done piece,” Roma 

says. Then she scanned the original and started to add 

color. “I selected the colors from a palette that can be 

adjusted to get a million choices, and I filled the spaces 

and shapes simply by pouring color into the selected 

area. The heart image called for warm reds and cool 

blues, so I sampled many combinations of those two, 

which proved easy to accomplish using Photoshop, esp-

cially since I knew I could revert to the original if I made a mistake.

For an advertisment in a newspaper, Roma 

needed to create a halftone version, so 

she converted the image to grayscale in 

Photoshop with one click of a mouse, then 

easily adjusted the contrast and curves of 

the halftone.

 Without much effort the Heart 

Illustration series was now ready to accom-

modate a variety of applications. The cli-

ent could use the heart to create prints and 

adorn T-shirts, or to appear in ads.

Plenty of programs 
Vector-based programs: 
n Adobe Illustrator 
www.adobe.com/products/illustrator/
n CorelDRAW 
www.corel.com
n Microsoft Expression Design 
www.microsoft.com/expression/products/Overview.
aspx?key=design
n Xara Xtreme
www.xara.com/xtreme
Pixel-based painting programs:
n Adobe Photoshop 
www..adobe.com/products/photoshop/family
n Corel Painter 
www.corel.com
n ArtRage 
www.ambientdesign.com
 

n Corel Paint Shop Pro
www.corel.com
3-D Software
n Houdini 
www.sidefx.com
n Zbrush 
www.pixologic.com/zbrush/features
n MOI3D 
moi3d.com
n Maxwell Render 
www.maxwellrender.com

How do you label works 
created with computer 
programs?
Sometimes people use many programs—they may scan 
the art into Photoshop, do some work to it, then bring 
it into Illustrator and finish it. Most of the time, the pro-
gram isn’t listed, but you can mention the size and type 
of paper the work was printed on or the printer that was 
used if the print is hanging in a gallery.
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ing processes to achieve a singular vision. Rosen uses 
digital images copied from her earlier works, which 
she scans directly into the computer, or she works 
with images taken with cameras. To the digital copy 
she then adds artist’s materials, such as paint, draw-
ings and collage elements to create new surfaces and 
intriguingly beautiful images. 

How does she transfer the digital copy? Rosen 
embeds computer manipulated digital images into gel 

“skins” (Golden clear tar gel and soft gel are favorites). 
To do this she coats the front of the digital reproduc-
tion with several layers of gel medium. Once those lay-
ers are dry, she soaks the paper backing in water and 

then rubs the backing off. The digital skin can then be 
incorporated into various applications. (To see photo-
graphs of this process, go to www.artistsnetwork.com/
acrylic-gel-transfer.)

Benefits: These digital images can be added to art-
work in layers under transparent textured surfaces or as 
transfers, which can then be drawn or painted on with 
traditional materials. Thus, one piece of art can have 
many different visual outcomes. Images can be printed 
on top of various surfaces using new Golden digital 
grounds. (To learn more, go to www.goldenpaints.com/
mixmoremedia/acgelskin.php).

For this painting (Untitled, above), Rosen 

took a digital image of a previous paint-

ing; she embedded the digital image in a 

tar gel skin, then painted the reverse side 

with tinted soft gel, which acted as a glue to 

attach the skin to a Claybord panel. She then 

added more layers of tar gel, matte medium 

and iridescent paints to embellish the piece.

 Rosen manipulated a digital photo of a 

dead seagull in Photoshop for (Untitled, at 

right), then made the print into a tar gel skin 

by painting the gel directly onto the ink-

jet print in multiple layers. She painted the 

reverse side of the print with iridescent pearl 

interference paint before adhering it to the 

canvas. 

Text continued on page 9
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Creating special 
effects in film 
and in prints

“The process begins with images of 
realistic but mostly unidentifiable 
objects,” says Kevin Mack. For his 
role as a director of visual effects in 
films, he has received many awards, 
including an Oscar for What 
Dreams May Come (1998); he also 
created stunning visual effects for 
Apollo 13, A Beautiful Mind, How 
the Grinch Stole Christmas, The 
Fifth Element and other films. 

As for the works he shows in 
galleries, they begin as paintings 
in Photoshop, or as renderings of 
models created in 3D software 
such as Houdini, Zbrush, and 
MOI3D.

“Often these images also serve 
as completed works themselves. 
Self-Awareness Mechanism is an example of such a piece,” recounts Mack. “It’s an 
absurd imaginary device (reminiscent, perhaps, of a diving bell) that inspires a 
laugh, I hope, and perhaps some self-awareness. It was modeled using MOI3D 
and Houdini. The materials, lighting and rendering were created using the Max-
well Renderer, which is a physically based renderer that simulates light, mate-
rials and optics at the spectral level for extremely realistic renderings.” —M.B.

Self-Awareness Mechanism  

(digital print) by Kevin Mack

“My pursuit is psycho-active art ... 
with a bit of ironic humor. In other 
words, I like to make stuff that’s fun 
to look at.” Kevin Mack

Meet the artists
n Ursula Roma 
www.ursularoma.com
n Merle Rosen 
www.merlerosen.com
n Q. Cassetti 
www.qcassetti.com
n Kevin Mack 
www.kevinmackart.com
n Eunjung Hwang 
www.eunjunghwang.com
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Using Adobe Illustrator to create  
a portrait 

“I generally shoot photographs at a fairly high resolution to capture detail in the 
eyes,” says Q. Cassetti. “In Photoshop I’ll convert the image to CMYK (a color 
space format used by printers and graphic designers) and save out two or three 
approaches so I can contrast them: one being very bright and high-key; the others 
covering midtones and shadows. 

“I bring all three ‘exposures’ into Adobe Illustrator and register them on dif-
ferent layers. I lock the layers and place 
a layer on top of the image. I draw the 
image (breaking the image into a high-
light, a midtone or two and shadow) 
using vectors to create shapes. I build 
shape upon shape, adjusting colors, 
grouping shapes into new shapes. I edit 
and shift the color as I go. Portrait of Mol-
lie (at right) was a test project in which 
I used a photograph I shot of a model 
lit with a single light source gelled with 
orange. The remarkable thing about the 
image is that the model was very expres-
sive and adding the hat changed the 
dynamic of the image and her posture.” 

Portrait of Mollie (digital print)  

by Q. Cassetti

Q. Cassetti created this portrait of her daughter, 

Portrait of Kitty (above; digital print) from a pho-

tograph, using Adobe Illustrator.

“I build shape upon shape, 
adjusting colors, grouping shapes 

into new shapes.” Q. Cassetti
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Step 3: Painting with Adobe Illustrator 
As an illustrator and designer with no background in 
painting, Q. Cassetti (see opposite page) cites among 
her influences Hans Holbein and Ludwig Hohlwein, 
as well as American artists Charles Burns and Sheph-
ard Fairey. Cassetti creates portraits from photographs, 
using Adobe Illustrator. Her process is straightforward. 
She scans a photo into Photoshop, then brings it into 
Illustrator and creates several contrasting layers, which 
she then colorizes. Next she uses the pencil and brush 
tools to create and highlight details within the por-
trait. This process can take many hours to several days, 
depending on the amount of detail she wishes to retain 
for each image. 

Benefits: You can transform a photograph into 
a vibrantly colored, expressive work of art that can 
suggest more about the subject’s personality than a 
straightforward, realistically rendered painting. 

Bubble (above; digital print) and Pigs (below; 

digital print) by Eunjung Hwang

From drawing to digital 
print and animated movie 
The pictures shown on this page are from a series of digi-
tal prints called Future Creatures, which are are also being 
developed into an animation project with the same name. 
Eunjung Hwang’s process starts with a hand-drawn drawing or painting (mostly in 
pencil or in gouache on paper). The artist doesn’t “consider the drawing as part of 
the process for the final work or digital print,” but contends that the drawing and 
the print exist as “separate works.”

“I scan or take a photo of the original drawing,” she says. “Then I draw every-
thing on the computer again—loosely basing my creation on the drawing. It’s not 
that I scan the image and then retouch it; it’s more that I re-create the image on the 
computer. For this process, I use a Wacom Tablet in the same way I use my pencils. 
When I first started this process, I used Painter (software), but now I use Flash. I like 
Flash because it’s simple and easy to use; it takes up only a little file size; it creates 
vector-based graphics much more successfully than Painter does and, also impor-
tant, I can create animations, not only images and prints.” 

Born in Seoul, Korea, Eunjung Hwang lives and works in New York City. She 
completed an MFA degree program in computer arts at the School of Visual Arts, 
New York, in 2002. Her animations and new media works have been shown at a 
number of exhibitions and festivals internationally, including Exhibit 3 (The Digital 
Hub, Ireland) and Impakt Festival 2003 (the Netherlands).
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WWhat in the World would compel a tradi-
tional artist, one long grounded in the archival 
milieu of painting, drawing and printmak-
ing, to cross over to the dark side—to make 
digital art, despite the fact that it’s excluded or 
rejected from exhibitions—fits into no category 
listed in the prospectus for competitive shows, 

and is, in fact, reviled by a 
majority of artists? here’s 
my story.

Way back in 1987, as 
i casually looked out the 
window of a friend’s apart-
ment, i noticed a spiral of 
smoke trailing into the sky. 

a strange location for smoke, i thought, and 
then, making a quick cognitive map of the city, 
i realized it was coming from my own studio! 
By the time my friend and i got there, it was 
dark; there were huge flames, sparks in the sky, 

firemen and trucks everywhere. i looked into 
the tall, arched windows of my beautiful stu-
dio on the sixth floor and saw flames. “That’s 
my whole life up there” was all i could say to 
the reporter who had positioned herself next to 
me. The studio was gone—hundreds of paint-
ings, sculptures, handmade tools, paint, rolls 
of canvas, stretchers—everything, gone. no 
place to work, no materials to work with. But 
not all was lost; i could still go home. There i 
had a Macintosh 512K computer (rudimentary 
by today’s standards), with software called 
MacPaint with which i could create primi-
tive images and then print them out with my 
dot-matrix printer in black and white, on roll 
paper with holes on the edges and perforations 
between the sheets. hardly a medium to make 
art, you would say, but that was long ago.

today my work is constructed digitally, 

virtual

ABoVe: This is a slightly more literal 
female partial torso. The transparency 
and iridescence suggest a mystical or 
transcendent quality in Femme (digital 
image). Strange objects inside the body 
suggest the life experiences that we 
collect over time.

Text continued on page 14

A traditionally trained painter turns to digital art, using 3D modeling 
to explore a fascination with flower and female forms.

turning in space
BY MCCrYSTle WooD
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Creating Virtual Objects
i usually begin with a body or a flower in mind. The body is always abstract and 

organically built; the flower is invented but may loosely resemble an existing flower. 

Mademoiselle began with the idea of a young woman. i wanted her to be lovely and 

sweet and pure with all the hope for the future. a primary visual resource for this 

and other works is the work of maria sibylla merian, a german artist and naturalist 

(1647–1717) who documented the metamorphosis of a butterfly.

1. The Axes: When i begin a project, 

the screen is empty except for a grid 

that shows the three XYZ axes’ direc-

tions. X is the up-and-down measure-

ment; y is the left-to-right measurement, 

and Z measures dimensions in and out 

from a center point.  These are called 

vector data.

2. Building the Flower: each part 

of the flower was built separately. i 

wanted the body to be a stem that 

curled around to indicate enough of 

the anatomy to show that it wasn’t an 

actual plant, but i also didn’t want to be 

too literal. The blue line with yellow dots 

is called a spline path. a circle is “swept” 

along the path to create the skin of the 

body shape.

5. Refining the Flower/Female: The 

flower was built using a process called 

lofting. This process is a lot like knitting, 

adding to the form row by row as you 

would if you were working with yarn. in 

this case, each row is a spline path, and 

each spline path adds length and shape 

to define the skin of the form.

6. Form Completed: Here’s the com-

pleted flower, showing both the rows of 

splines and the wireframe (or mesh).

Want to Try  
3D Modeling?

• Google sketchUp (sketchup.

google.com) is one of the 

easiest introductory software 

programs for 3D modeling. it’s 

free, easy to download, has 

tons of tutorials and works on 

both MAC and WIN. it’s pos-

sible to do impressive-looking 

work in 3D after just an hour 

or so by just playing around to 

learn the tools.

• What you’ll need—hardware 

and software requirements: 

google the phrase “google 

sketchUp system require-

ments” to bring up the specs to 

improve performance.

• Take a class at a regional col-

lege. in one semester you’ll 

have a complete introduction 

to the basic concepts, and 

you’ll be able to create sophis-

ticated images and animations. 

• Read a book. A superb book 

with visual explanations, 

Getting Started with 3D: A 

Designer’s Guide to 3D & 

Illustration by Janet ashford, 

John odam and Victor 

gavenda, describes the entire 

process of 3D modeling from 

start to finish. The book was 

first published by PeachPit 

Press in 1998, and updated 

versions are available at 

amazon.com.

• Check out a few other indus-

try-standard 3D modeling soft-

ware titles: 3ds max; blender, 

Fragmotion, maya, Lightwave 

3D, softimage and Zbrush.
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3. Four Perspectives: in a three-

dimensional, virtual space, objects can 

be seen and moved from all directions. 

This picture shows four windows, each 

displaying a different perspective that 

i used to look at the scene. i work 

intuitively, quickly moving any view or 

window in order to work on a given 

shape. 

4. Building the Image: Picture A shows the stem rendered and what the spline 

(the path that led to the artifact) would look like if it were showing. i duplicated the 

spline path and pulled it next to the neck so you can see what’s actually inside the 

neck. The picture of the roots (B) shows that the roots are made the same way. 

each one of the rootlike pieces has its own little spline path that i made. i told each 

one to begin at one size and end at the other size. in this case, i’m telling the pieces 

to be smaller and smaller. When you look at the forms, you can see a torso and 

other variations of a woman’s body. 

7. Embellishing the Form: This pic-

ture shows the flower, with materials 

(textures and colors) and lighting added. 

getting to the final shape and lighting in 

this image took about three weeks and 

45 iterations.

8. Side Petals: i wanted her side pet-

als to look as if they were the remains 

of the outer cover of the flower before 

it blossomed. i placed the side petals 

carefully along either side of the flower 

to create the illusion that she’s bursting 

out of her restraints. To make the side 

petals, i duplicated the original flower, 

broke it into two pieces and then manip-

ulated the mesh with a magnet tool (just 

as you would with clay) to “sculpt” new 

shapes.

9. Creating the Illusion: i wanted the 

side petals to look degraded and old, so 

i created a material that uses an alpha-

channel, which creates the illusion of 

holes in the surface. it’s a special kind 

of material so i don’t have to put actual 

holes into the mesh itself.

A B
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What Software Do I Use?
i use a program called maxon cinema 4D (www.maxon.net), an industry-

standard 3D and animation software that enables me to express my visual 

ideas more closely to what i have in mind than with any other medium. of 

course, the 3D component renders the resulting work dramatically differ-

ent from my earlier paintings and prints, but if i were to line up a sequence 

of every stage of my art (in the span of 35 years—including painting, print-

making and sculpture—you would see a high correspondence and reso-

nance among the works. The imagery, color palette and conceptual ideas 

are consistent and have evolved together.

10. Viewing the Scene: next i put lights 

and cameras into place. This “scene” used 

12 lights and 11 cameras to get just the right 

angle for the flower. To do this i had to be 

able to view the scene from many different 

angles as i rotated it in space. 

11. Rendering the Scene: after all of the 

“geometry” is complete, i made a rendering 

of the scene. rendering is a process that 

converts all of the vector information into 

pixels. When the pixel image is opened in 

Photoshop, the only changes that can be 

made are the color of the pixels. (only the 

3D modeling scene allows objects in the 

scene to be moved in space.) With this step, i 

completed Mademoiselle.

ABoVe: Mademoiselle (digital image)
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but intuitively and visually—just like any other 
art. My digital work uses no photography 
or Photoshop. The software i use is called 
3D modeling, and the process is very much 
like making a sculpture. i build or construct 
objects that have all the dimensions and the 
three-dimensional mass of a real, physical 
object, except that they are virtual objects and 
they exist in virtual space. Virtual means that 
they aren’t physical forms, but their shape, 
color and position are actually seen as numbers 
by the 3d program. The numbers are “under 
the hood,” so i usually ignore them. 

Sculpting in Space
in art school i became aware of the great beauty 
of the female form and saw similarities between 
the figure and flower forms. now when i begin 
to create a flower, it often becomes a figure, 
or a figure becomes a flower, or sometimes 
they exist together in a single form. if you 
look carefully through one of my images you 
may see as many as five or six different female 
figures, usually as part of another form.

in my version of digital art, every element 
in the picture, from the smallest hair to the 
largest flower, is created as a wireframe object. 
The wireframe mesh functions—and even 
looks—much like clay in the real world. it can 
be stretched, squashed, twisted, extruded and 
manipulated intuitively and organically in any 
way. a finished work is composed of thousands 
of these objects. each one has a name and an 
address that keeps track of its location in the 
virtual space that’s called XYZ space (See the 
demonstration starting on page 38).

in 3d modeling i create the objects and 
the materials, which are like wallpaper and are 

“wrapped” onto the mesh objects; i add cam-
eras and lights and move everything around in 
space—it’s a little like lighting a stage set for a 
play. often when making an object, i’ll build 
as many as 30 different versions in order to get 
just the form i want. The process is a lot like 
sketching in the physical world, except that 
sketching is a lot quicker!

When the “scene” is finished—when i’m 
happy with the way it looks—a process called 
rendering takes place. This process takes all of 
the mathematical data and converts that data 
into pixels. once the image is in pixels, it can’t 
be manipulated in three-dimensional space; 
it’s a fixed size and color. and, need i say, it’s a 
work of art. n

Meet McCrystle Wood
“When I began making art again, after a studio fire and many intervening years, it 
was scary. The whole act felt new; learning a new craft (3D modeling) took time; 
the work looked different, and the response 
was mixed and confusing. Still, the act of mak-
ing the work was joyful, so I persevered,” says 
McCrystle Wood, who earned a BFA and an 
MFA from Indiana University. A professor in 
the College of Design, Architecture, Art and 
Planning at the University of Cincinnati, Wood 
is the coordinator of the Foundation Studies 
program. To see more of her work, visit www.
wooloo.org/mccrystle.

ABoVe: Not all of my works include a flower, but all include one or more sug-
gestions of female and male forms. In La Pomme (French for The Apple, digital 
image), the female is floating, upside down in the upper right part of the form. The 
spiral is suggestive of a sense of endlessnes or maybe of rebirth and renewal. 

Text continued from page 10
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C h a p t e r  T w o

hile you don’t have to be thoroughly 
impressive or entirely competent, you’ll 

get the most out of your Wonderland expe-
rience with us if you’ve had some basic training 

in Adobe Photoshop. If you’re new to Photoshop, 
you may want to start with an online workshop or 
a class at your local community college. If you’re 
standing at a bookstore wondering if your commu-
nity even has a college, do yourself a favor and grab 
a neighboring book on the shelf that teaches the 
basics of Photoshop. 

Once you’ve cozied up to your digital paint-
brushes and become friendly with your image 
editing tools, you’ll be good to go. Following are the 
basic supplies you’ll need for your trip into Won-
derland. And should you get lost along the way, 
we’ve provided a reference guide to the basic terms 
and techniques we’ll be using.

If Wishes Were Wings

W

Getting Started

15
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From Digital Art Wonderland:

Creative Techniques for Inspirational Journaling and Beautiful Blogging
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Technique Guide
Our reference guide, located on page 
18, includes official Adobe Photoshop 
terms and menu items in this guide, 
as well as our own pet names for in-
house tricks and tips. 

Primary Tools
While not all of the following tools 
will be utilized every time you sit 
down to create a digital wonder, most 
of them will become your bosom 
buddies as they prove to be useful 
again and again.

Photoſhop 
Most of our techniques can be han-
dled by CS3, though for optimum 
performance you’ll want to work 
with CS5. If you’re working with 
Photoshop Elements, you’ll have to 
upgrade because most of our tutorials 
will not be compatible with that ver-
sion of the program.

Digital Camera 
While not entirely necessary, you’re 
sure to get a lot of mileage out of a 
good digital camera. We use a variety 
of them, and some of the cheaper 
models will give you exactly what you 
need as a basis of an interesting piece 
of art, so don’t get sidetracked by all 
the bells and whistles on the latest 
models. (Unless of course the sales-
person at your local electronics shop 
is totally cute and you’re in need of a 
bit of eye candy. If that’s the case, by 
all means, shop till you drop.)

Scanner 
A good scanner is an essential element 
if you want to work with old ephem-
era or personal effects. While there 
are many projects you can enjoy that 
utilize existing stock imagery or other 
copyright-free digital images available 
online, a scanner allows you access to 
just about any piece of intrigue you 
find lying around your house. A piece 
of old fabric? Scan it and turn it into a 
headdress on a monkey. That antique 

doily? The scanner will capture all its 
detail. A digital camera can also give 
you similar results, but a scanner often 
allows you to capture more detail with 
less visual noise. 

Ephemera 
When we refer to ephemera, we’re 
specifically addressing interesting bits 
of papery things: ticket stubs, maps, 
photos, theater programs, lunch bags, 
crumbled remnants of wrapping 
paper. These will not only add decora-
tive design elements to your art, but 
you can build them up layer by layer to 
create atmosphere and texture.

Stock Imagery 
Whether you use stock photography, 
illustration or vector graphics, much 
of your finished piece will likely con-
tain stock imagery, at least for the exer-
cises in this book. Old books (printed 
before 1923) and printed material 
are our number one source for stock 
imagery, but we also use photography 
sites and other online resources for 
our graphics. 

Digital Textureſ 
Reading of this book, and your 
subsequent tour through Digital 
Wonderland, will assure one thing: 
Textures are your new best friend! 
We’ll be pulling from a number of 
sources to create our own custom tex-
tures, but many can be found free 
of charge on stock art and photogra-
phy sites. You can also use your own 
photography as the basis of intriguing 
textures you’ll use repeatedly in your 
projects.

Paintſ, Paperſ and Penſ 
If you want to use your new Photoshop 
skills on top of a manual collage or 
other piece of art, you’ll want to start 
with these basics to make your foun-
dational piece of art. There are plenty 
of books and online tutorials about 
making collages with these traditional 
materials. You’ll use your scanner or 
digital camera to get these collages to 
the screen.

Love Is

Something to Say 
Few of our pieces come from a doo-
dle. Fewer still come from a precon-
ceived notion of what the finished 
piece will look like. The majority of 
our pieces, and certainly the strong 
ones, start with an emotion or inten-
tion. Silas or I will have an idea and 
begin shaping that idea with mood 
and atmosphere on the digital page. 
We move elements around until we 
achieve the right feeling. Whether we 
use verbal (words in the design) or 
nonverbal (images only) communica-
tion, our best art has something to say. 
 Just like a great story brought to 
the screen through motion pictures, 
the actors, scenery, music and lighting 
are all important, but it’s the dialogue 
in most cases that brings that story 
home. What’s your story at this pres-
ent moment? What do you want to 
convey? Who is your viewer? These 
are questions that, when answered, or 
even contemplated, can provide the 
biggest source of inspiration and guid-
ance for your art.

Senſe of Wild Abandon 
The most thrilling things happen when 
we voyage into the unknown with a 
sense of adventure. Digital art, unlike 
many of the traditional manual art 
forms, allows for radical experiments 
that can be replicated or erased in a 
matter of moments, without “ruining” 
your canvas. Let these new freedoms 
create in you a reckless sense of won-
der and wild abandon. You cannot go 
wrong because every new turn, even if 
it was one you hadn’t intended on tak-
ing, will reveal new and surprising cre-
ative horizons. Lighten up! Stay loose! 
Welcome surprises. And if you abso-
lutely insist on sticking to your original 
vision, there’s always the “undo” tool! 
We have a banner hanging above our 
studio door with a quote from Scott 
Adams that reads, “Creativity is mak-
ing mistakes. Art is knowing which 
ones to keep.”
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Adjustment Layers
Adjustment Layers are basically 
nondestructive layers that contain 
the effects of the Layer Blending 
Modes (see right). This allows you 
to add an Adjustment Layer without 
physically changing the image data. 
Therefore you can go back in at any 
time and change the parameters of 
the Adjustment Layer without caus-
ing loss of image material or decline 
of image quality.

Think of it as a tinted transpar-
ency that floats on top of your image 
and can be removed or altered with-
out permanently affecting the under-
lying picture.

To apply Adjustment Layers, go 
to the layer palette and click on the 
symbol of the black-and-white half 
circles on the very bottom.

Layer Blending Modes
These are modes that will change 
how a layer will relate to (or visually 
mix with) the next underlying layer.

The best way to understand this 
tool is by using it on various surfac-
es. Often the result is unpredictable, 
which adds an element of surprise 
to the creative process. You activate/
change the Layer Blending Mode in 
the drop-down menu at the top of the 
layer palette.

Technique Guide
Throughout this book, we refer to many basic Adobe Photoshop terms but also mix in a few of our 
own. You may know some of these tools by other names, so we’ve written the following technique 
guide to establish many of the names of the tools we’ll be using. 

Adjustment Layers

as to make it appear more realistic. It 
is a very frequently used effect but, 
without some hand alteration, can 
appear flat rather than three-dimen-
sional. 

See page 20 to view the Layer 
Style menu. See the tutorial on page 
131 for a technique on how to achieve 
a more realistic Drop Shadow. There 
are other helpful tips in the typogra-
phy section beginning on page 122.

Layer Blending Modes

Color Tinting
Color Tinting is another term we 
made up that simply describes a 
process to affect the overall color 
tint. (For more on this technique, see 
“Applying Textures”, page 32 step 4.)

Drop Shadow
The Drop Shadow  in Photoshop 
terminology is a layer style that can 
be found via the menu: Layer > Layer 
Style > Drop Shadow. It creates a 
shadow behind a chosen element, so 
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Hue/Saturation

Layer Blending Options 
conte xt menu

Golden Ratio
The composition of an image always 
consists of two or more elements 
(or areas of the image) standing in a 
particular relationship to each other. 
The Golden Ratio is a term used in 
graphic illustration stating that the 
ultimate weight distribution in any 
composition is a ratio of 2:3. We elab-
orate on this on page 124.

Hue/Saturation
This tool can be found in the menu: 
Image > Adjustments > Hue/
Saturation.

With it you can change the 
saturation of colors and also make 
very drastic color alterations. For 
best results, use it on an Adjustment 
Layer (see page 18) in order to main-
tain maximum flexibility on any 
future alterations. Changes made 
with this function via the main 
menu are permanent, while the 
Adjustment Layer can be changed 
any time later in the process.

Rough Cut and 
Fine Cut
These are not Photoshop terms, but 
we use them to describe options for 
cutting an element away from its 
environment. Rough Cut refers to 
a quick cut out of an element. The 
edges stay rough. This is a good 
option if you just want to see, for 
example, how a particular figure will 
look against a background you’ve 
created. You may place it here, or 
move it there, or discard it alto-
gether. It would be a waste of time to 
put a lot of effort into cutting it out 
properly just to find out you might 
not end up using it after all. Fine Cut 
is the step of cutting out an element 
precisely, once you know you want 
to keep the element and use it in 
your project.

For a Fine Cut, you’ll most like-
ly use the following tools: Quick 
Selection tool, Magic Wand, Pen 
Tool and Lasso, but most of all, the 
Masking Mode. If you want to learn 
more specifics about the mentioned 
tools, please consult your Photoshop 
manual or the Help option in the 
program.

Layer Blending 
Options
Not to be confused with Layer 
Blending Modes! The function of 
the settings in this window will help 
control what portions of the under-
lying (or current layer) will become 
transparent. There are a multitude 
of options in this dialog box, but our 
main focus within the parameters of 
this book will be the transparency, 
which is accomplished by moving 
the sliders back and forth. This is 
described in more detail in our first 
tutorial on page 23.

You can get to the Layer Blending 
Options by clicking on the far-right 
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Layer Style menu

Levels menu

little context-menu symbol on the 
upper gray bar of the layer palette. Or 
find it under Layer > Layer Style > 
Blending Options.

The actual window looks like the 
image to the right.

Layer Opacity
A layer’s overall opacity determines 
to what degree it obscures or reveals 
the layer beneath it. A layer with 1 
percent opacity appears nearly trans-
parent, whereas one with 100 percent 
opacity appears completely opaque. 
Use the opacity slider in the top right 
corner of the layer palette.

Levels
This tool allows you to change the 
balance of light versus dark in your 
image. There are many ways in there 
to lighten or darken a picture or to 
take the depth out of the black areas. 
Most of the time you will use the 
middle slider to simply alter the bal-
ance of the weight between light and 
dark. (This tool is also best used on 
an Adjustment Layer).

20

Z8908i_3_Ch2_014-021.indd   20 2/23/11   2:42:16 PM
20 www.artistsmagazine.com



Magic Wand
The Magic Wand tool lets you select 
a consistently colored area (for 
example, an object surrounded by 
blue sky) without having to trace 
its outline. You specify the selected 
color range, or tolerance, relative to 
the original color you chose.

Masking
The Quick Mask Mode allows you 
to paint any area red (temporarily) 
with any brush size to specify areas 
you want to turn into a selection. 
It is often the most effective way to 
create a selection with maximum 
control over the exact edges.

To use this feature, turn the 
Quick Mask Mode on and off by 
using the tool on the very bottom of 
the tool palette.

When you return to the normal 
mode, you will see that the previ-
ously painted areas are now a selec-
tion, ready to be copied or pasted or 
otherwise edited.

Quick Selection
The Quick Selection tool makes a 
selection based on color and texture 
similarity when you click or click-
drag the area you want to select. The 
mark you make doesn’t need to be 
precise, because the Quick Selection 
tool automatically and intuitively 
creates a border.

Click or click-drag over the area 
that covers the range of colors in the 
object you want to select, and then 
release the mouse button.

Tools menu
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Reſpond to What Is
Select a handful of digital elements; 
start with twenty or so. Load them 
into Photoshop and forbid yourself, for 
the sake of playfulness, access to any 
other elements. (This works equally 
well with a manual collage; just gather 
your ephemera and place it in your 
work space. Turn your back on all 
other elements.) Create a background 
for your elements that pleases you. 
Now arrange the elements one at a 
time. Perhaps use some and not others. 
Twist them, turn them, scatter them, 
but allow each layer to be built upon 
the previous layer. The idea is to let 
each element tell you what’s next until 
you feel the piece is finished. 

Note: Sometimes this experiment 
ends with surprising and delightful 
results. Other times you’ll want to 
use the results to line your birdcage. 
However, the emphasis should be 
placed not on the result, but on what 
you learned along the way. Every piece, 
every step is teaching us something. If 
it’s not, you’re not taking risks. 

Do Over
Once you’ve created a piece you 
love, play with deconstruction. Save 
the original, and then open it in 
Photoshop and tear it apart. Create 
three other pieces using only ele-
ments or layers from the original 
piece. Remember those paintings by 
Andy Warhol that showed the por-
trait of a famous person in various 
color palettes? It’s almost as if Andy 
couldn’t decide which color set was 
best, so he found a way to use them 
all at once. Well, this is like that, only 
you’re not trying to do one piece 
in different colors, you’re instead 
using the basics of your first piece 
to answer the question “What else 
might this be?”

Quick–Fire Experimentſ
Set your alarm clock or kitchen timer 
for one hour, or thirty minutes, or ten. 
It’s up to you what time frame you 

Tools of the Trade 
for Play
Your sense of adventure and willing-
ness to be surprised are the best tools 
for play. Playing is all about discovery, 
and for that we must yield control to 
the muse. Sometimes it’s easy to play. 
We wake up feeling frisky and can’t 
wait to get to the studio. Other days 
we need a prompt. Or a smoking-hot 
branding iron. 

My friend Walter relayed a story 
from his early days as a professional 
fashion-magazine photographer in the 
1950s. He showed up for his first day 
of work, and his boss handed him a 
pair of black high heels. “Photograph 
these and make them appear allur-
ing.” Walter went away and did just 
that, handing in his results the next 
day. His boss looked at the glossies 
and responded, “Well done. Now do 
it again from a different angle.” Walter 
found this to be a strange request, but 
he did as he was told. Again, the fol-
lowing morning, his photos earned a 
“well done” and another directive to 
shoot again. This scenario repeated 
itself for the first two months of his job, 
until he felt he knew these shoes inti-
mately—too intimately. He was seeing 
them in his sleep, in waking visions, 
and it was driving him crazy. When 
he finally blew up at his boss, saying 
he couldn’t take it another day, he was 
rewarded with a smile. “So now you’re 
ready.” He was given a fashion shoot 
with a live model the next day, but now 
recalls that the tedium of those two 
months taught him more about pho-
tography than anything that followed 
in his forty-year career as a profes-
sional photographer. “It drove me mad, 
but it taught me to see creatively.” 

While I’m not going to assign sixty 
days of repetitious assignments, I am 
going to suggest a few exercises for 
courting the muse and a few for keep-
ing your artistic eyes seeing creatively.

choose, but we’ve found one hour or 
less to be ideal. Any more than that, 
and you’re more tempted to edit. During 
your block of time, create willy-nilly. Let 
yourself go. Listen to the canvas and what 
it has to say as it evolves. The idea here 
is to make spur-of-the-moment choices 
and to build one spontaneous move-
ment upon another to see what emerges 
in a short amount of time. We’re tricking 
the brain into right-side enthusiasm and 
attempting to muffle the critical left side 
of the brain that wants to criticize or edit. 
It’s all about the riff!

One Color Family
Choose a handful of elements in one 
color family. All reds and oranges, or all 
blues and purples. Perhaps black and 
gray. For this one piece, play only with 
one color family. Stripping away the pos-
sibilities of deep contrast forces our eyes 
to see differently. 

Two Leaſt Favorite Colorſ
A friend of mine told me a story from 
his college years. One of his professors 
asked each student to write down their 
two least favorite colors to work with. 
Once all students had written down the 
colors and turned them in, the professor 
gave them their next assignment: Create 
a painting using only those two colors. 
There are gifts waiting for us inside our 
resistance. Try this out. Work with your 
two least favorite colors and watch what 
arises as you loosen your resistance.

Storybook Character
This is one of my favorites! Find a face 
that inspires you. It can be from an old 
photograph, a Victorian painting or a 
snapshot of you. Take it into Photoshop 
and create a fairy tale around it. Will this 
be Sleeping Beauty? Prince Charming? 
Little Bo Peep? Little Boy Blue? Whoever 
this figure is, tell the story using visuals, 
but don’t tell the story with environment. 
Create a body, a dress or a headdress that 
tells the viewer who this character is. 
(When we played with this experiment, 
the result was Alice in Wonderland, as 
seen on page 8).
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